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 أنواع الحاسبات
 :تختلف الحاسبات باختلاف طرق استخدامها ويمكن تقسيمها إلي ما يلي

 (Personal Computer)الحاسب الشخصي

أو حاسب سطح المكتب نتيجة لأن حجمه يسمح بوضعه  (pc) عادة ما يطلق عليه الحاسب الشخصي
استخدام الحاسب الشخصي في المكاتب والأعمال المنزلية لان أسعاره  فوق سطح المكتب ولقد انتشر

 .في متناول الشخص العادي ويعتبر الآن الحاسب الأكثر استخداما في العالم

 

 
 (laptop) الحاسبات المحمولة

وهى حاسبات صغيرة محمولة في حجم حقيبة اليد يمكن التنقل بها بسهولة. وهى تتميز بصغر 
المفاتيح.كما يمكن توصيلها بشاشة ولوحة مفاتيح في الحجم الطبيعي وذلك في حالات الشاشة ولوحة 

ساعات العمل الطويلة.وتعتبر الحاسبات المحمولة في نفس قوةالحاسب الشخصي رغم ارتفاع 
 .سعرها ضعف سعر الحاسبات الشخصية و يرجع ذلك لصغر حجمها

 

 
 (palmtop)حاسب الكف

ف و يمكن نقل الملفات المخزنة عليه إلى الحاسبات الشخصية، وهو حاسب صغير في حجم الك
 . ويعتبر منخفض السعر مقارنة بالحاسب المحمول
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 (servers)أجهزة الخادم

وهي أجهزة حاسب تستخدم في شبكات الحاسب لتكون المركز الرئيسي للشبكة حيث يتم تخزين 
وية كفاية لتتمكن من استيعاب عدد الحاسبات البيانات وإدارة الشبكة، ويجب أن تكون هذه الحاسبات ق

الكبير عليها ، وفي الواقع مع تطور قوة الحاسبات الشخصية أصبحت تستخدم كحاسبات خادمة وبدأ 
 .الفرق بين الحاسبات الشخصية والخادمة يتقلص في الوقت الحالي شيئاً فشيئاً 

 

 
 شكل للحاسبات الخادمه وما يتصل بها من أجهزه

 

 

 الكمبيوترمكونات 
 Software ، والبرمجيات Hardware (وهى نوعان المكونات الماديه )أجهزة

 Hardware (المكونات المادية للحاسب )الأجهزة

الوحدات المادية هي أي جزئ ملموس ومرئي في الحاسب الآلي أو متصل بالحاسب الآلي. وتنقسم 
 : الوحدات المادية إلى ثلاث أقسام هي

 وحدات الإدخال Input Unite. 

 وحدات الإخراج output Unite. 
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 وحدة المعالجة المركزية CPU. 

 

 Input Unite أولا: وحدات الإدخال

 . وهى تلك الأجهزة والوحدات المسئولة عن إدخال البيانات والبرامج المختلفة للجهاز

  : أمثلة لوحدات الإدخال

 

 : Key Board لوحة المفاتيح .1

أهم وحدات إدخال البيانات للحاسب الآلي. وتستخدم لوحة المفاتيح في إدخال  تعتبر لوحة المفاتيح من
 :بيانات من حروف و أرقام. و تحتوي لوحة المفاتيح علي

o  ،أ، ب(مفاتيح الحروف والرموزB  ،A  ،"  ،& ). 

o مفاتيح اللوحة الرقميةو التي تستخدم في إدخال الأرقام و العمليات الحسابية. 

o  التي تستخدم في تحريك مؤشر الكتابةمفاتيح الأسهم و. 

o مفتاح العالي (Shift)  ويستخدم في إدخال الحروف والرموز المكتوبة أعلي
 .أزرار الكتابة وله استخدامات أخرى

o مفتاحي تغيير اللغة (Alt + Shift).حيث يستخدم مفتاحي (Alt + Shift)  في
 Alt) ى العربية. أما مفتاحيالجانب الأيمن من لوحة المفاتيح لتغيير لغة الكتابة إل

+ Shift)  في الجانب الأيسر من لوحة المفاتيح فلتغيير لغة الكتابة إلى
 .الإنجليزية
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 : Mouse الماوس .2

 .هي إحدى وحدات إدخال الحاسب الآلي. و للفأرة زران أيمن و أيسر

ة في جميع تحريك الفأرة يتحرك مؤشر الفأر وقد يوجد زر في الوسط في بعض الانواع . عند 

  . و هو علي شكل سهم الاتجاهات علي الشاشة.

 :و للفأرة ثلاث استخدامات هي

o الإشارة (Pointing)  بحيث تستطيع الإشارة إلى أي
 .شيء موجود علي الشاشة

o الاختيار(Selection)  بالضغط علي زر الفأرة الأيسر
 .أثناء الإشارة علي شيء معين علي الشاشة

o النقل (Move)الضغط علي الزر الأيسر  باستمرار
للفأرة مع سحب الشيء الذي تريد نقله الي المكان 

 Drag)الجديد و تسمي هذه العملية سحب وإسقاط

and Drop). 

 

 :(Scanner) الماسح الضوئي .3

يعتبر الماسح الضوئي وحدة من وحدات إدخال الحاسب الآلي. و يتم توصيله بالحاسب الآلي لإدخال 
جميع أنواعها بحيث تستطيع رؤيتها علي الشاشة وإعادة استخدامها و التغيير الصور و الرسومات ب

 .فيها

 

 
 صوره للماسح الضوئي
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 :الميكروفون .4

هو أيضا وحدة من وحدات إدخال الحاسب الآلي و يستخدم في إدخال الأصوات بحيث يمكنك إدخال و 
 . تسجيل صوتك أو بعض المحادثات أو المحاضرات

 :(Digital Camera) الكاميرا الرقمية .5

هي أيضا وحدة من وحدات إدخال الحاسب الآلي. و يتم توصليها بالحاسب الآلي لإدخال صور تم 
 .التقاطها بحيث تستطيع مشاهدتها علي الشاشة و التغيير فيها

 (Disk drives) وحده الاسطوانات .6

 CD انات المدمجوالاسطو floppy disk  يمكن إدخال البيانات عن طريق الاسطوانات المرنة

ROM والاسطوانات الرقمية DVD . 

 output Unite ثانيا: وحدات الإخراج

وهى تلك الوحدات المسئولة عن جميع عمليات عرض واستخراج النتائج التى قام بتنفيذها الحاسب 
 وفقا للتعليمات التي قام المستخدم بإصدارها إليه

  : أمثلة لوحدات الإخراج

 

 Monitors شاشة العرض .1

و هي من أهم وحدات إخراج الحاسب الآلي بحيث تظهر الشاشة ما يتم إدخاله للحاسب الآلي من 
 حروف و أرقام و صور الخ. كما تعرض الشاشة البيانات المسجلة مسبقا علي جهاز الحاسب

 :(Speakers) السماعات .2

راج الأصوات السماعات هي وحدة من وحدات إخراج البيانات من الحاسب الآلي. وتستخدم في إخ
 والأغاني والموسيقي. و يمكنك التحكم في درجة علو و انخفاض الصوت

 :(Printer) الطابعة .3

وهي أيضا وحدة من وحدات إخراج البيانات من الحاسب الآلي. و تستخدم في إخراج البيانات 
 صور( مطبوعة علي أوراق -أرقام  -والمعلومات )حروف 
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 صوره للطابعه

 (PLOTTERS) الراسمات .4

وهي أيضا وحدة من وحدات إخراج البيانات من الحاسب الآلي. و تستخدم في إخراج الرسومات 
 البيانية والهندسية بأحجام كبيره مطبوعة علي أوراق

 
 (plotter) صوره للراسم

 CPU ثالثا: وحدة المعالجة المركزية

 : تنقسم وحدة المعالجة المركزية إلى ثلاث أجزاء وهى

  المنطقىوحدة الحساب Arithmetic logic Unit (ALU). 

 وحدة التحكم Control unit (CU) . 

 الذاكرة الرئيسية Main Memory . 
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 و أجزائهاCPU شكل توضيحي للـ

 (ALU) وحدة الحساب والمنطق .1

تقوم هذه الوحدة بإجراء العمليات الحسابية مثل عمليات الجمع والطرح والقسمة ... الخ والعمليات 
هى أي عملية التى يتم فيها المقارنة بين كميات أو عمليات فرز وترتيب مثل عمليات أكبر من المنطقية 

 . أو أصغر من أو يساوى

 (CU) وحدة التحكم .2

تقوم بتنسيق العمليات بين الوحدات المختلفة للحاسب حيث أنها تتحكم فى كل المدخلات والمخرجات 
 .من والى الوحدات المختلفة فى الحاسب

 
 وضيحي للأجهزة المكونة للحاسبشكل ت

عند تشغيل الحاسب يتم تحميل البرامج المستخدمة والتي سبق تخزينها على الاسطوانة الصلبة إلى 
ويستخدم الحاسب هذه الذاكرة في تنفيذ الأعمال، وتخزين البرامج  (RAM).ذاكرة الوصول العشوائي

الجهاز أو انقطاع التيار الكهربي ليعاد تحميلها والبيانات الجاري معالجتها. وتفرغ الذاكرة عند إغلاق 
 .بالبرامج عند إعادة تشغيل الجهاز

 الذاكرة .3

يحتاج الحاسب إلي استرجاع وتذكر المعلومات التي يتعامل معها تماما كما يحتاج الإنسان كذلك لذا 
ية باستخدام يجب حفظ المعلومات إما مؤقتاً أو بصفة دائمة.تعالج المعلومات ثم تخزن في صورة رقم

(.ونحن في حياتنا نستخدم النظام 1،  0النظام الثنائي، وهو النظام العددي الذي يستخدم رقمين فقط)
 .(9العشري الذي يستخدم عشرة أرقام )من صفر إلي 

 تقاس سعة الذاكرة بالوحدات الأساسية الأربعة الآتية :وحدات القياس الذاكره : 

 الخانة البايت Byte : الذاكرة المطلوبة لتمثيل حرف واحد هى مقدار
اى  ( Bit بالتدوين الثنائى، وتتكون الخانة )البايت( من ثمانى خانات )بت

 .(1،  0رقم ثنائى والتى يمكنها تمثيل الرقمين الثنائيين )

 الكيلو بايت Kilobyte: KB  = بايت 1024والكيلو بايت الواحد. 

 الميجابايت Megabyte :: اخت ( صارالميجا بايت M أو MB ) = 

 .كيلوبايت1024

 الجيجا بايت Gigabyte:اختصار ( الجيجا بايت G  أو GB ) = 1024 

 .ميجابايت
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 أقسام الذاكرة الرئيسية Main Memory :  

 : تنقسم الذاكرة الرئيسية إلى ثلاث انواع هي

 ذاكرة التداول العشوائي Random Access 

Memory(RAM) :  البيانات والبرامج من وحدة تستقبل هذه لذاكرة
الإدخال كما تقوم باستقبال النتائج من وحدة الحساب والمنطق وتقوم 
بتخزينهم تخزيناً مؤقتاً ) حيث تفقد هذه الذاكرة محتويتها بمجرد فصل 
التيار الكهربي ( لذا سميت بالذاكرة المؤقتة أو المتطايرة . وكلما زادت 

حجم البرامج التى يمكن تداولها فى سعة الذاكرة زادت كمية البيانات و
 . نفس الوقت

 ذاكرة القراءة فقط Read Only Memory (ROM):  تحتوى على
البرامج والبيانات الأساسية اللازمة لتشغيل الكمبيوتر وتلك البيانات 
والبرامج قد تم تسجيلها من قبل الشركة المصنعة . وهى ذاكرة ثابتة لا 

ى وسميت بذاكرة القراءة فقط لأنه لا يمكن تتأثر بانقطاع التيار الكهرب
الكتابة عليها أو التعديل أو الإلغاء لمحتوياتها بواسطة المستخدم بل يمكن 

 .فقط قراءة ما بداخلها

 الذاكرة المخبأة (cache memory):  وتستخدم خلال عمليات التشغيل
وهى عبارة عن ذاكرة تخزين مؤقت ذات سرعة عالية جدًا تفوق سرعة 

اكرة الرئيسية. وتستخدم للتخزين المؤقت للبيانات والتعليمات المطلوب الذ
استرجاعها مرات عديدة أثناء عمليات تشغيل البيانات مما يساعد على 

كيلو  512سرعة تشغيل البيانات . وتقدر سعة الذاكرة المخبأة بحوالي 
 .بايت أو اكثر

 وحدة التخزين Storage Devices: 

وحدات التى يمكن الاحتفاظ بالبيانات والبرامج عليها وتنقسم تلك وحدات التخزين هى ال
الوحدات إلى: الاسطوانات الصلبة، والاسطوانات المرنة، والاسطوانات المضغوطة 

، والأسطوانة الرقمية المتعددة الجوانب، والشريط الممغنط، وذاكرة  (CD )اسطوانات الليزر
 .الفلاش

 
 التخزينشكل يوضح أمثله لوحدات 

 الاسطوانات الصلبة Hard Disks :  وحده صغيرة فى حجم كف اليد
 (CPU) تقريبا توجد بصفة دائما ومثبته فى وحدة المعالجة المركزية

وتتميز الاسطوانة بكبر سعتها التخزينية حيث تصل تلك السعة التخزينية 
 . الى تخزين اكثر من عشرة آلاف كتاب أى عشر مليارات حرف تقريبا
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 شكل القرص الصلب

 الاسطوانات المرنة Floppy Disks:  ويوجد منها نوعين هما اسطوانات
بوصة وهى المستخدمة الآن فى عملية حفظ البيانات نظر  3.5مرنة 

لم  5.25صغر حجمها وكبر حجم السعة التخزينية لها اسطوانات مرنة 
 . تعد تستخدم الآن نظر صغر حجم السعة الخزينية لها وكبر حجمها

 

 الاسطوانات المضغوطة (اسطوانات الليزر CD) Compact 

Disks :احدث   الاسطوانات المضغوطة أو الاسطوانات الليزر تعتبر
وسائل التخزين حيث تستخدم فى تخزين الصوت ولقطات الفيديو، حيث 

أي ستمائة وخمسون مليون حرف.  650تصل سعتها التخزينية الى 
 .التسجيل عليها إلا مرة واحدة فقط  لا يمكنويعيب على هذه النوعية أنها 

 

 الأسطوانة الرقمية المتعددة الجوانب (DVD Digital Versatile 

Disk):  وهو نوع من الأسطوانات المدمجة عالي السعة يستخدم لتخزين
 (CD) جيجا بايت من المعلومات. وتستخدم الأسطوانة المدمجة 2-10

بدلا من  في تخزين أفلام بجودة عاليةلتخزين الموسيقى وعادة ما تستخدم 
 .شرائط الفيديو

 ذاكرة الفلاش (Flash Memory) : هي ذاكرة تستخدم في حفظ البيانات
وتتميز بصغر الحجم والسعة التخزينيه الكبيرة حيث تصل الي اكثر من 
جيجا بايت، كما يمكن أيضا مسح البيانات من عليها والكتابة عليها اكثر 

 . USB توصيلها بالحاسب بواسطة مدخلمن مرة ويتم 
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 صوره للفلاش

بعد شرح أجزاء الحاسب المادية بالتفصيل لابد من إيضاح العلاقة ومدي ترابط كل 
جزء مع الآخر للقيام بالعمليات المطلوبة من الحاسب فمثلا عن القيام بعمليه حسابيه 

ذلك يتم المعالجة  ما أولا لابد من إدخال الأرقام بواسطة وحدات الإدخال وبعد
بواسطة وحده التحكم المركزي للحصول علي النتائج التي يتم إخراجها من خلال 
وحدات الإخراج ثم تخزينها بواسطة وحدات التخزين والشكل التالي يوضح ترابط 

 أجزاء الحاسب مع بعضها

 

 

 Software (المكونات غير المادية )البرمجيات

نوعين من البرامج برامج مستخدمة بواسطة الحاسب وتسمى برامج يمكن تقسيم برامج الحاسب إلي 
 النظام، وبرامج تستخدم بواسطة المستخدم وتسمي البرامج التطبيقية
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 نظام التشغيل .1

هو النظام الذي يحتوي علي كل الأوامر التي تمكن الحاسب من أداء عمله مثل عملية بدء التشغيل 
 floppy) والأسطوانة المرنة(Hard Disk) الأسطوانة الصلبةوالإظهار علي الشاشة واستخدام 

disk) لتخزين المعلومات. 

بإدارة البرامج مثل معالج الكلمات والألعاب ومتصفح  (operating system) ويقوم نظام التشغيل
وينظم العرض  (processor)الإنترنت. فهو يستقبل الأوامر من هذه البرامج ويمررها إلي المعالج ،

ي الشاشة. ويأخذ النتائج من المعالج، ثم يقوم بإرسالها للتخزين علي الأسطوانة الصلبة أو للطباعة عل
علي الآلة الطابعة. برامج التشغيل موجودة دائما في الحاسب وتبدأ في العمل أوتوماتيكيا عند تشغيله 

 .عنه.فنظام تشغيل الحاسب كالمحرك بالنسبة للسيارة كلاهما لا يمكن الاستغناء 

 : من أشهر برامج التشغيل

o windows( 95,98,2000,XP) 

o LINUX 

o UNIX 

o DOS 

 البرامج التطبيقية .2

هي كل البرامج التي تعمل علي الحاسب مثل معالج الكلمات والجداول الإلكترونية وقواعد البيانات 
البرامج تعرف وأدوات العروض وبرامج الناشر المكتبي والألعاب وبرامج الوسائط المتعددة. وهذه 

 ومن أنواع البرمجيات التطبيقية .(Microsoft Office ) لدى المستخدمين للتطبيقات باسم

o برمجيات النظام (System Software):  هي برامج موجودة علي الحاسب
ومخزنة مسبقاً علي الأسطوانة الصلبة عند شرائه .عند استخدام الحاسب لأول مرة 
ربما يحتاج الأمر إلي إدخال بعض المعلومات لتشكيله. وهذا مثل أن نقوم بتعريف ا 
لحاسب بنوع الطابعة المتصلة به ، وإذا كان هناك وصلة للإنترنت وما شابهه ذلك 
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ن أضافه بعض المهام إلي برامج النظام كلما دعت الحاجة إلى ذلك. فمثلا إذا . يمك
قمت بتغيير الطابعة فإننا نحتاج إلي تحميل برامج إضافية للحاسب لنتعامل مع 

 .الطابعة الجديدة

o البرمجيات التجارية (Commercial Ware):  تعتبر البرامج المعروضة للبيع
علي سبيل   (Microsoft office) لمكتببرامج تجارية. كمجموعة برامج ا

المثال. وتتاح البرامج التجارية لآلاف من الاستخدامات مثل الرسم والمحاسبة 
وإدارة الأعمال وتحرير الأفلام. والبرامج التجارية غالبا ما تكون مرخصة 
للمستخدم بدلا من مجرد بيعها بالطريقة المتعارف عليها، مع توضيح الشروط 

 .مرتبطة باستخدامها، كما هو موضح سابقالمختلفة ال

o برمجيات المشاركة (Shareware):  يقوم العديد من المبرمجين والهواة بكتابة
البرامج التي تكون متاحة مجانا. وتوزيع هذه البرامج قد يكون بواسطة الإنترنت أو 
اسطوانة توزع مع المجلات. وهذه برامج عادة ما تكون متاحة لبعض الوقت قبل 

ائها.والدفع للحصول على هذه البرامج يعتمد علي الثقة والشرف.لو أراد شر
المستخدم الاستمرار في استخدام البرامج بعد الفترة التجريبية فيجب عليه تسديد 

 الرسوم للمؤلف

o برمجيات بدون مقابل (Free Ware):  وتكون مشابهة لبرامج المشاركة بدون
مقابل لها وبعض المؤلفين مسئولين عن  رسوم فهي توزع مجانا ولا يتوقع تسديد

جودة البرنامج. وكما هو الحال في البرامج المتاحة فإنها تأتي أيضا بشروط بعض 
المطورين ربما يوزعون النسخ الأولي مجاناً لكي يشعر المستخدمين بفائدة 
 البرنامج . وغالبا ما يحتفظ مؤلفو هذه البرامج بكل الحقوق القانونية لبرامجهم. ولا

 .يسمح بنسخ أو توزيع لهذه البرامج

o البرمجيات العامة(Public Ware) :  هذه البرامج تكون متاحة للاستخدام العام
 .أي إنها متاحة مجانا ويمكن نسخها وتعديلها ،لا يوجد رسوم لاستخدامها

 

 الفرق بين التطبيقات والبرامج

يقوم بعمل شئ معين مثل الكشف عن هو مجموعة من الأوامر التي توجه الحاسب لأن  :البرنامج
وإزالة الفيروسات يمكن أيضا التفكير في البرنامج علي أنه مجموعة من التعليمات والتي كتبت بلغة 

يفهمها الحاسب والذي لا يفهم اللغة البشرية فأي شيء يقوم المستخدم بكتابته علي لوحة المفاتيح 
 .بتنفيذهيترجم إلي النظام الثنائي قبل أن يقوم الحاسب 

الحاسب ينفذ التعليمات ويعالج البيانات ويخرج المعلومات بصورة يفهمها المستخدم عادة علي 
 .الشاشة أو الطابعة الورقية

وهي برامج مثل معالج الكلمات تستخدم في العمل اليومي. إذا كنت تعمل بالرسومات  :التطبيقات
تعمل بالموسيقي فأنك سوف تستخدم  فأنك سوف تستخدم تطبيقات الرسومات المختلفة. لو كنت

برامج الموسيقي. تكون برامج الطباعة والمحاسبة واسعة الاستخدام في الأعمال . يوجد برامج لكل 
 .الأغراض المطلوبة. ويمكن استخدام المصطلحات " برامج " و" تطبيقات " بصوره متبادلة

 

 العمل مع نظام الويندوز ء بد

تشغيل الكمبيوتر يجب علينا انتظار نظام التشغيل حتى تتمة الإقلاع و نتأكد من الإقلاع الكامل بظهور سطح يدعى ء عند بد
سطح المكتب عليه رموز خاصة بعمل نقوم من خلالها بالتعامل مع الكمبيوتر و برامج الكمبيوتر على سطح المكتب نلاحظ 

لمستخدم للماوس يتحرك المؤشر على سطح المكتب عموديا  و افقيا وجود سهم نتحكم به من جهاز الماوس حسب حركة ا
 على كل سطح المكتب. 
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  MOUSEالفأرة 

يتم استخدام الماوس للتفاعل مع العناصر على الشاشة كاستخدام اليدين للتعامل مع الكائنات في الواقع. يمكنك نقل الكائنات 
ثم يصبح ، نك إنجازها. يجب أن تعمل الماوس عند تشغيل الكمبيوترأخرى يمكء وأشيا، هاءأو فتحها أو تغييرها أو إلقا

يمكنك تبديل دور ، بعض التغييرات على وظيفتها وعلى مظهر مؤشر الماوس وسلوكه. على سبيل المثالء بالإمكان إجرا
أو تعيينه ، حهأو تحسين وضو، يمكن تغيير مظهره، أو ضبط سرعة النقر المزدوج. بالنسبة لمؤشر الماوس، أزرار الماوس

 الكتابة. و يحوي على زرين رئيسيين وهما: ء ليختفي أثنا

زر الماوس الثانوي: هو الزر الأيمن في الماوس الزر الذي نستخدمه لعرض القوائم المختصرة أو الميزات الأخرى  
 الخاصة بالبرامج. 

خدمه للنقر أو النقر المزدوج. و لها زر الماوس الرئيسي: هو الزر الأيسر في أغلب أجهزة الماوس الزر الذي نست 
 وظائف عديدة وهي: 

 النقر المفرد ضغط زر الماوس الأيسر وإفلاته لتحديد رمز ما.  -1

 النقر المزدوج ضغط وإفلات زر الماوس مرتين متتاليتين سريعتين على رمز محدد في الشاشة .  -2

ضغط المستمر على زر الماوس الأيسر ومن ثم إزاحة السحب التأشير على أحد البنود المعروضة على الشاشة ثم ال -3
 الماوس إلى مكان مختلف وإفلات الزر.

 
 انواع انظمة التشغيل

 هنالك العديد من التصنيفات لانظمة التشغيل ومنها ما يعتمد على :
 عدد المستخدمين التي يدعمها نظام التشغيل .1

o Single-user 

o Multi-User 

 التشغيل بالتواليعدد المهام التي ينفذها نظام  .2

o single task 

o Multi-Task  
 
 

  -أساسيات واجهة نظام التشغيل ويندوز :
 : Desktopسطح المكتب 

يعمل سطح ، يمثل سطح المكتب منطقة الشاشة الرئيسية التي تظهر أمامك بعد تشغيل الكمبيوتر 
فإن هذه ، المكتب في الكمبيوتر كسطح يمكنك مزاولة أعمالك عليه. عند فتح برامج أو مجلدات

على سطح المكتب مثل ء البرامج والمجلدات تظهر على سطح المكتب. ً يمكنك أيضا وضع أشيا
 ت والمجلدات وترتيبها بالكيفية التي ترغب فيها. الملفا

ويتم تعريف سطح المكتب بشكل أوسع أحيانا بحيث يضم شريط المهام. يوجد شريط المهام أسفل 
ويسمح بالتبديل بينها. كما ، الشاشة. ويظهر البرامج التي يتم تشغيلها على الكمبيوتر في الوقت الحالي

الذي يمكنك من خلاله الوصول إلى البرامج والمجلدات "، يحتوي أيضا على الزر "ابدأ 
 وإعدادات الكمبيوتر. 
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 : Task barشريط المهام 
هو الشريط الأفقي الطويل الموجود في أسفل الشاشة. بخلاف سطح المكتب الذي يمكن أن يختفي 

 المهام غالبا ما يكون مرئيا طوال الوقت. فإن شريط ، النوافذ المفتوحةء ورا
 
 
 

 يتكون شريط المهام من ثلاثة أقسام رئيسية: 
 الذي يفتح القائمة 'ابدأ'. '،  الزر 'ابدأ 
 ظهر البرامج والملفات المفتوحة ويتيح إمكانية التبديل بينها بطريقة القسم الأوسط الذي ي

 سريعة.

الإعلامات الذي يتضمن ساعة ورموز )الصور الصغيرة( التي تشير إلى حالة بعض البرامج ء جز
 الكمبيوتر. عض إعدادات وب
 

  -اتبع الخطوات التالية : Task barلعرض برنامج في شريط المهام 
 . انقر بزر الماوس الأيمن فوق البرنامج الذي تريد عرضه في أعلى القائمة ابدأ. 1
 Pin to. من القائمة الفرعية التي تظهر كما في الشكل التالي نختار إضافة إلى القائمة "ابدأ" )2

Taskbar  . ) 
  

 
 
 . فيتم عرض البرنامج في قائمة العناصر المضافة في المنطقة أعلى الخط الفاصل في القائمة ابدأ. 3
 

  -اتبع الخطوات التالية : Task barحذف برنامج من شريط المهام 
 . انقر بزر الماوس الأيمن فوق البرنامج الذي تريد حذفه في أعلى القائمة ابدأ. 1
 unpin this program fromالقائمة الفرعية التي تظهر نختار إضافة إلى القائمة "ابدأ" ). من 2

Taskbar ) 
  

 
  Task bar. يتم حذف البرنامج شريط المهام 3
 

 ( Startالقائمة ) 
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تعد القائمة "ابدأ" البوابة الرئيسية إلى برامج الكمبيوتر ومجلداته وإعداداته. ويطلق عليها قائمة لأنها 
ء تعد هذه القائمة هي المكان الذي تنتقل إليه لبد، وكما يبدو من كلمة 'ابدأ'، توفر قائمة من الاختيارات

  -هذه الأنشطة الشائعة:القائمة "ابدأ" للقيام بأو فتحها.يمكنك استخدام ء تشغيل الأشيا
 

 تشغيل البرامج ء • بد
 • فتح المجلدات شائعة الاستخدام 

 • البحث عن الملفات والمجلدات والبرامج 
 • ضبط إعدادات الكمبيوتر 

  Windows• الحصول على تعليمات حول نظام التشغيل 
 • إيقاف تشغيل الكمبيوتر 

 أو التبديل إلى حساب مستخدم آخر Windows• تسجيل الخروج من 
 

 Windows7الشروع في استخدام القائمة "ابدأ": ]اكتب عنوان المستند[ 
  

انقر فوق الزر ابدأ الموجود في أسفل الركن الأيمن من الشاشة. أو اضغط على ، لفتح القائمة 'ابدأ'
 الموجود بلوحة المفاتيح. فتظهر قائمة أبدا كما في الشكل التالي .  Windowsمفتاح شعار 

 

 
 رئيسية: ء تتكون القائمة "ابدأ" من ثلاثة أجزا

 الأيمن الكبير قائمة صغيرة تضم البرامج الموجودة على الكمبيوتر. يمكن ء يعرض الجز
يمكن لمظهرها أن يختلف. ، وبالتالي، تخصيص هذه القائمةللشركة المصنعة للكمبيوتر 

 يؤدي النقر فوق كافة البرامج إلى عرض قائمة كاملة للبرامج. 
 

 يسمح لك بالبحث عن البرامج والملفات الموجودة ، الأيمنء يوجد مربع بحث أسفل الجز
 مصطلحات البحث. على الكمبيوتر بواسطة كتابة 
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 لوصول إلى المجلدات والملفات والإعدادات والميزات شائعة الأيسر إمكانية اء يتيح الجز
أو إيقاف تشغيل  Windowsالذي تنتقل إليه لتسجيل الخروج من الاستخدام. كما أنه المكان 

 الكمبيوتر. 
 
 
  
  
  
  
  
  
  
  
  
  

 فتح البرامج من القائمة "ابدأ": 
يعد فتح البرامج المثبتة على الكمبيوتر لديك من الاستخدامات الأكثر شيوعا للقائمة "ابدأ". ولفتح 

انقر فوقه. يتم فتح البرنامج ويتم إغلاق القائمة ، الأيمن من القائمة "ابدأ"ء برنامج موجود في الجز
 "ابدأ." 

 
ء الأيمن. يعرض الجزء سفل الجزانقر فوق كافة البرامج أ، إذا لم يظهر أمامك البرنامج الذي تريده

 متبوعة بقائمة من المجلدات. ، الأيمن قائمة طويلة بالبرامج الموجودة بترتيب أبجدي
يتم تشغيل هذا البرنامج وإغلاق القائمة "ابدأ". والآن ماذا يوجد ، وبالنقر فوق أحد رموز البرامج

لتظهر قائمة ، ى سبيل المثالعل، مزيد من البرامج. انقر فوق البرامج الملحقة؟ داخل المجلدات
بالبرامج المحفوظة في هذا المجلد. انقر فوق أي برنامج لفتحه. للعودة إلى البرامج التي شاهدتها عند 

 انقر فوق الخلف بالقرب من أسفل القائمة. ، فتح القائمة "ابدأ" أول مرة
 

يظهر مربع ، و اسمه. عندئذفحرك المؤشر فوق رمزه أ، إذا لم تكن متأكدا مما يقوم به أحد البرامج
لتظهر قائمة بالبرامج المحفوظة في هذا ، البرنامج. على سبيل المثالا على وصف لهذا يحتوي غالب

، المجلد. انقر فوق أي برنامج لفتحه. للعودة إلى البرامج التي شاهدتها عند فتح القائمة "ابدأ" أول مرة
 انقر فوق الخلف بالقرب من أسفل القائمة.

 
يظهر مربع ، فحرك المؤشر فوق رمزه أو اسمه. عندئذ، لم تكن متأكدا مما يقوم به أحد البرامجإذا 

تؤدي الإشارة إلى "الحاسبة" إلى عرض ، على وصف لهذا البرنامج. على سبيل المثالبا يحتوي غال
يضا مع مهمات حسابية أساسية باستخدام حاسبة على الشاشة." تعمل هذه الخدمة أء هذه الرسالة: "أدا

 العناصر الموجودة في الجانب الأيسر من القائمة "ابدأ." 
تتغير قوائم البرامج الموجودة في القائمة "ابدأ". ويحدث ذلك لسببين. ، ربما تلاحظ أنه بمرور الوقت

بوضعها في ، يتم إضافتها إلى القائمة "كافة البرامج". الثاني، هو أنه عند تثبيت برامج جديدة، الأول
من لمساعدتك في الوصول إليها بطريقة أسرع. تكشف القائمة 'ابدأ' البرامج التي تستخدمها الأيء الجز
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 وتقوم ، بشكل أكبر
 
 

 لعرض برنامج في أعلى القائمة ابدأ : 
 . انقر بزر الماوس الأيمن فوق البرنامج الذي تريد عرضه في أعلى القائمة ابدأ. 1
 ( .  Pin to Start Menuإلى القائمة "ابدأ" ). قائمة الفرعية التي تظهر نختار إضافة 2
   

 
  

 . فيتم عرض البرنامج في قائمة العناصر المضافة في المنطقة أعلى الخط الفاصل في القائمة ابدأ. 3
 

 حذف برنامج في أعلى القائمة ابدأ: 
 . انقر بزر الماوس الأيمن فوق البرنامج الذي تريد حذفه في أعلى القائمة ابدأ. 1
(  unpin from Start Menuمن القائمة الفرعية التي تظهر نختار إضافة إلى القائمة "ابدأ" ). 2

 (Remove from Start List) أو الأمر 

 

 
 . يتم حذف البرنامج في قائمة العناصر المضافة في المنطقة أعلى الخط الفاصل في القائمة ابدأ. 3
 

 مربع البحث: 
 
 موجودة على الكمبيوتر.ء للبحث عن أشيا الأكثر ملائمةمربع البحث' هو أحد الطرق ' 

خلال مربع 'البحث' البحث في البرامج وكافة المجلدات حيث يتم من ، لا يهم موقع العناصر بالضبط
في المجلد الشخصي )الذي يتضمن المستندات والصور والموسيقى وسطح المكتب والمواقع الشائعة 
الأخرى(. ويقوم أيضا  بالبحث في رسائل البريد الإلكتروني والرسائل الفورية المحفوظة والمواعيد 

 الاتصال. وجهات 
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 مربع البحث في القائمة 'ابدأ' 
ء افتح القائمة 'ابدأ' وابدأ الكتابة. لا يلزم النقر داخل المربع أولا . أثنا، لاستخدام مربع 'البحث'

الأيمن من القائمة 'ابدأ.'سيظهر البرنامج أو ء تظهر نتائج البحث فوق مربع البحث في الجز، الكتابة
 الملف أو المجلد كنتيجة من نتائج البحث. 

 
  Recycle Binسلة المحذوفات 

ولكنه يذهب أولا إلى سلة  -فإنه لا يتم حذفه في الحقيقة نهائيا ، عندما تقوم بحذف ملف أو مجلد
يمكنك ، لأنك إذا غيرت رأيك وقررت أنك تحتاج إلى ملف محذوف، جيدء المحذوفات. هذا شي

 استعادته مرة أخرى. 
  

 
 

 سلة المحذوفات" عندما تكون فارغة )إلى اليمين( وعندما تكون ممتلئة )إلى اليسار( 
يمكنك تفريغ سلة ، إذا كنت متأكدا من أنك لن تحتاج إلى العناصر المحذوفة مرة أخرىًً 

 نهائيا واستعادة مساحة القرص التي كنت تستخدمها. المحذوفات. سيؤدي ذلك إلى حذف العناصر 
 
 

 استرداد الملفات من سلة المحذوفات 
فهو ينتقل في الواقع إلى "سلة المحذوفات" حيث يتم تخزينه ، عندما تقوم بحذف ملف من الكمبيوتر

مؤقتا إلى أن يتم إفراغ "سلة المحذوفات". مما يتيح الفرصة لاستعادة الملفات التي تم حذفها بطريق 
 الخطأ وإعادتها إلى مواقعها الأصلية. 

 
 فتح 'سلة المحذوفات' بالنقر المزدوج فوق سلة المحذوفات على سطح المكتب. . ا1
 واحد مما يلي: ء . قم بإجرا2

كما في الشكل "،.  Restoreثم انقر فوق " ، انقر فوقه بزر الماوس الأيمن ، • لاستعادة ملف
 التالي 

  

 
 

من شريط الأدوات. كما في ، ثم انقر فوق استعادة هذا العنصر، انقر فوقه، • لاستعادة ملف
 الشكل التالي 

كافة استعادة "،  Restore allثم انقر فوق " ، تأكد من عدم تحديد أي ملف، • لاستعادة كافة الملفات
 العناصر من شريط الأدوات. 

 
 فسيتم استعادة الملفات إلى موقعها الأصلي على الكمبيوتر. 
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 حذف الملفات بصفة دائمة من سلة المحذوفات 
لإزالة الملفات نهائيا من الكمبيوتر والاستفادة من أية مساحة على القرص الثابت كانت تحتلها هذه 

المحذوفات'. يمكن اختيار حذف الملفات الفردية من 'سلة المحذوفات' يجب حذفها من 'سلة ، الملفات
 التالي ء أو تفريغها كلها في الحال. قم بالجرا

 
 . افتح 'سلة المحذوفات' بالنقر المزدوج فوق سلة المحذوفات على سطح المكتب. 1
 واحد مما يلي: ء . قم بإجرا2

وبعد ذلك ، deleteثم اضغط فوق 'حذف' ، الأيمن انقر فوقه بزر الماوس ، • لحذف ملف واحد نهائيا
 انقر فوق موافق. 

 

 
 
 ثم انقر فوق نعم. ، انقر فوق إفراغ "سلة المحذوفات"، في شريط الأدوات، • لحذف كافة الملفات 
  

 
ثم ، يمكنك إفراغ 'سلة المحذوفات' . بدون فتحها عن طريق النقر بزر الماوس الأيمن فوقها  -تلميح:

 النقر فوق إفراغ سلة المحذوفات 
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• يمكنك حذف أحد الملفات بصفة دائمة من الكمبيوتر دون إرساله إلى 'سلة المحذوفات' عن طريق 

 (.Shift+Delete) ثم الضغط فوق، النقر فوق الملف
 
 

 : My computerجهاز الكمبيوتر 

 

و محرك الأقراص ، محتويات القرص الثابت، يظهر جهاز الكمبيوتر محتويات القرص المرن
ومن ، انقر فوق ابدأ، و لوحة التحكم لفتح "جهاز الكمبيوتر"و محركات أقراص الشبكة ، المضغوطة

أو اظهار رمز ء يمكن اخفالجديد ثم انقر فوق جهاز الكمبيوتر في نظام ويندوز الجديد في النظام ا
 جهاز الكمبيوتر من على سطح المكتب باتباع 

 

 : All Programsقائمة كافة البرامج 

عبارة عن قائمة تحوي اختصارات لجميع البرامج التي تم اعدادها على جهاز الكمبيوتر و أيضا 
 التشغيل جميع برامج و تطبيقات نظام 

 

  MY Documentsمجلد المستندات: 

عبارة عن مجلد يتم فيه حفظ كافة الملفات الخاصة بمستخدم معين و يمكن أيضا حفظ الصور و  
 و اظهار مجلد المستندات من و على سطح المكتب . ء اخفاالملفات الصوتية الخاصة يمكن 
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 : Control Panelلوحة التحكم 

  

لوحة التحكم عبارة عن نافذة تحوي على العديد من الأدوات المخصصة و التي يتم استخدامها لتغيير 
سلوكه و تساعد هذه الأدوات في ضبط الإعدادات التي تجعل من طريقة عمل ويندوز و كيفية 

 استخدام الكمبيوتر أكثر امتاعا . لفتح لوحة التحكم:

 

 تار لوحة التحكم. م نخـــ. نفتح قائمة ابدأ الكلاسيكية ث1

. عند فتح نافذة لوحة التحكم تظهر عناصر النافذة بشكل فئات و هي طريقة عرض خاصة في نظام 2
للتبديل إلى طريقة العرض الكلاسيكية من النافذة الموجودة على يمين  Windows XPالتشغيل 

 واجهة النافذة نضغط على التبديل إلى طريقة العرض الكلاسيكية 

 

 :  Shut Downيل إيقاف التشغ

العمل بجهاز الكمبيوتر إغلاق جهاز الكمبيوتر بشكل آمن و يتم ذلك من خلال ء يجب عند انتها 
 TShutابدأ ثم اختيار أمر إيقاف تشغيل الكمبيوتر الضغط بزر ماوس الأيسر على زر 

Down"25T 25  فعند النقر على هذا الزر يتم إغلاق جهاز الكمبيوتر بشكل آمن وعند النقر فوق "
" إلى عرض إحدى القوائم التي تحتوي على خيارات TShut Downالسهم الموجود بجوار الزر "

إعادة ( ،  Log offتسجيل الخروج )( ،  Switch userلتبديل المستخدمين )  -إضافية وهي :
 " Sleep، " " السكون  lockقفل " "،  Hibernateالاسبات " ،  "Restartالتشغيل " 

 

 

 

 •SwitchUser :- عند للمستخدم الجديد لنافذةا خلف مفتوحةج لبرامقي ايبي الذلمستخدم(ل ا) تبدي 
 مرةه دخولل لتسجيل الأوالمستخدم  يعودي كه خروجل وتسجيل لعمن امي ينتهى حته دخولل تسجي

 أخرى 
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  •Log Off :- ع يستطيى حت مشتغلة لحاسبةي اويبقج لبرامع اجميق يغلي الذلخروج (ل ا)تسجي
 ليها. ه إدخولل تسجين خرمم أمستخد

  •Lock :- ) ل بالدخوم لهص لمرخص االأشخا ءباستثنال لدخون امص شخنع أي يمي الذ)القفل
 لحاسبة. الى ا

  •Restart :- تشغيلها يعيد ثم  لحاسبةف ايوقي الذالتشغيل( )أعادة 

  •Shut Down:- (ف إيقا )لعمل ن اع لحاسبةف اوتتوقج لبرامع اجميق تغلث حيالتشغيل 

  •Sleep :- ) السكون  حالةي فقى ويبل العم واجهةل لتشغيم انظا يحفظث حي) السكون 

  

  

  

  7طريقة إظهار أيقونات ) الكمبيوتر + لوحة التحكم + المستندات ( على سطحالمكتب ويندوز 

تظهر واجهة سطح المكتب كما في الشكل أدناه .. حيث نلاحظ فقط إيقونة"  7بعد تنصب ويندوز 
Recycle Bin  " 

  

  

  -نتبع الخطوات التالية :7ولإظهار الإيقونات على سطح المكتب في الويندوز 

  Start. من قائمة ابدأ 1

 . اضغط بزر الماوس الأيمن على الإيقونة المطلوب إظهارها على سطح المكتب 2
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3 . Show on Desktop الأمر نختار ثم 

 

  

إظهار الساعة: عرض ساعة رقمية على شريط المهام و تعرض الساعة و الوقت كما هو محدد 
إلى الساعة لعرض التاريخ و النقر فوقها لضبط يمكن التأشير بواسطة ساعة الكمبيوتر الداخلية و 

" كما change date and time settingالوقت و التاريخ. و لتغيير وقت الكمبيوتر ننقر على " 
 في الشكل أدناه . 

 

 

  Windowsالنوافذ 

 لنوافذ: ا معل العم

تظهر نافذته  Double clickعند الضغط بزر ماوس اليسار على الأيقونة نقرتين متتاليتين 
بنافذة لذلك مى و إطار يسع أمربفي لشاشة لى ايظهرع، ومجلدف أوملج أبرنامح فتد عنة ــالرئيسي

رمز عند فتحه يفتح بشكل نافذة لأن أي برنامج أو  Windowsبنظام سمي نظام التشغيل 
 اسمنظامالتشغيل.ءومنهناجا

 

 النافذة: ءأجزا

ض بعي فك تشتر النوافذ كافةن أ إلا ،خرىالى ا نافذة نملف تختة نافذل كت محتويان أن مم بالرغ
ل يمثي لمكتب الذح اسطعلى تظهرالنوافذ دوما ، المشتركةء لأشيان هذه ابي.ومن ل عامبشك ءلأشياا
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ء لأجزاس انفعلى النوافذ ي غالبية تحتو، ذلكالى لشاشة. وبالإضافة من الرئيسية ل امنطقة العم
 الأساسية. 

 

 

ث لبحت اوعمليات والمجلدات لمكتبال الى اللوصول التنق ءالنافذة هوجزيسر من الا ءالجز -1
ت لمجلداض ايضا توسيع" الكمبيوتر "لاستعراك ايمكنلثابتة. ص االأقرا كافةتى وح لمحفوظةا

 لفرعية". ت اوالمجلدا

 

ى خرت امكتبا وت امجلدال الى لانتقاالخلف والزرالأمام ل لزرم ااستخد -زراالأمام والخلف : -2
وبعد ، لعناوين"الأزرار مع" شريط ك اتلل النافذةالحالية .تعمغلاق ن ادول بالفع بفتحهات قم

لمجلد ع الى الزر "الخلف "للرجوم استخداك ايمكن، لعناوين" لتغيير المجلداتااستخدام" شريط 
قائمة نستطيع من خلالها السابق. او بالنقر على السهم الموجود بجانب زر الإمام والخلف فتظهر 

 التنقل بين المجلدات التي قمنا بفتحها كما في الشكل التالي 
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ت الملفا مظهر تغييرل مث ،شائعةم مها ءجرات لالأدواا شريطم استخدشريط الأدوات  -3
 لصورالرقمية ح اشرائض عر ءأوبد،مضغوطقرص ت على لملفاخ انس ،والمجلدات

 

 لمجلدع الى االرجو أو مختلفة مكتبة أو مجلدل الى للانتقان لعناويط ا اشريم استخدشريط العنوان  -4
 السابقة  المكتبة أو

 يبدأ المكتبة أو لمجلدل اداخث عن عنصر للبحث لبحع امربي ف جملة أو كلمةب اكت :مربع البحث -5
 الكتابة. في  ءالبد بمجردث البح

 

 شيوعا لأكثرص االخصائ لمشاهدةل التفاصي ءجزم استخد :التفاصيلء جز -6

 لملفات م امعظت محتويا لمشاهدة المعاينة ءجزم استخد :المعاينةء زر جز -7

ت لملفال اشك تغييرك يمكن ،مكتبة أو مجلدتح اي ف وترتيبها عندت والمجلدات لملفاض اعرزر  -9
يح تتتي لض اطريقة العرأو ، أوأصغرأكبر  لرموزن اتكول ان تفض قد ،لمثالل اسبيعلى  لنافذة.في ا
 ملف . ل كل حوت لمعلومامن امختلفة ع نواض أمكانية عرلك إ

 

 من خلال شريط العنوان يمكننا تحريك النافذة: 

 . نضغط بزر ماوس اليسار مع استمرار الضغط على شريط العنوان 1

 . نسحب النافذة إلى المكان المطلوب 2

 . ثم نحرر زر ماوس اليسار. 3

  

تكبير النافذة: يمكننا تكبير النافذة أي تأخذ أقصى حد لها و هو حجم الشاشة من خلال زر  
 تكبير الموجود على شريط العنوان 

عند تكبير النافذة إلى أقصى حد يتحول زر التكبير إلى زر استعادة إلى الأسفل بالضغط  
 السابق أي إلى حجم آخر مرة تم تكبير النافذة فيها. عليه يتم استعادة النافذة إلى حجمها 

 

 

 

Eng
.w

al
ee

da
lk
ur

di



تصغير النافذة: يمكن أيضا تصغير النافذة من خلال زر تصغير الموجود على شرطي  
العنوان إلى أدنى حد لها و هو وضع النافذة على شريط المهام بشكل زر لنتمكن من استعادة النافذة 

 ستعادة إلى الأعلى. إلى حجمها السابق و تسمى هذه الاستعادة إ

  

 اغلاق النافذة: يتم اغلاق النافذة من زر الاغلاق الموجود على شريط  

  

 و لكن يمكن أيضا اغلاق النافذة من عدة أماكن:  

 . نقرتين متتاليتين على أيقونة النافذة أو البرنامج من شريط العنوان. 1

 . نقرة واحدة على رمز النافذة من القائمة الفرعية التي تظهر نختار أمر اغلاق. 2

 . نفتح قائمة ملف ثم نختار أمر اغلاق. 3

. من شريط المهام نلاحظ الزر الخاص بالنافذة نضغط بزر ماوس اليمين على زر النافذة ثم نختار 4
 أمر اغلاق. 

 . Alt+ F4. نستخدم اختصار لوحة المفاتيح 5

  

 : صناديق الحوار

عبارة عن صناديق خاصة تظهر لتغيير إعدادات معينة خاصة بكائن معين مثال على ذلك الصندوق 
أو الصندوق الخاص بتغيير إعدادات خصائص سطح المكتب أي الخاص بخصائص شريط المهام 

 تطبيق(  –أمر ء إلغا –صندوق يحتوي على ثلاثة أزرار رئيسية )موافق 

 

ط على زر موافق يتم تطبيق الإعداد المحدد مع إغلاق صندوق الحوار الخاص موافق: عند الضغ
 بهذا الإعداد. 

كافة الإعدادات التي تم تعيينها مع إغلاق صندوق ء أمر: عند الضغط على هذا الزر يتم إلغاء إلغا
 الحوار. 

تطبيق: عند الضغط على زر تطبيق يتم تطبيق الإعدادات المحددة الجديدة مع الاحتفاظ بصندوق  
 . الحوار لتنفيذ إعداد آخر

 

 إعداداتالعرض : 
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ق طريعن  لنافذةل  الى هذه االوصوويمكن ف التوق وشاشةته اوإعدادب لمكتطح ابسم لتحككن ايم
 Personalizeختيار تخصيص "ن االمنسدلة يمكلنافذة ب ومن المكتطح اسعلى لزر على ا لضغطا

 " فتظهر نافذة كما في

 الشكل أدناه 

 

 

 

 حساب مستخدم جديد ء إنشا

  user accountsحساب مستخدم جديد نفتح لوحة التحكم ونختار الأمر ء لإنشا

 

كما في  Manage another accountلتظهر لنا نافذة حسابات المستخدمين ونختار منها الأمر 
 الشكل . 
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 الحسابات الموجودة حاليا على النظام لتظهر لنا النافذة التالية التي تعرض لنا كل 

 

 لتظهر النافذة التالية  Create a new accountومنها نختار الأمر 
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حيث نكتب فيها اسم الحساب الذي نريد إنشاؤه ثم نحدد الصلاحيات والأفضل أن تكون 
administrator  ثم نضغط زرCreate account الحساب وعرض النافذة النهائية ء ليتم إنشا 

 

 

 كلمة السر الخاصة بك ء تعديل أو إلغا 

 controlالتحكم لوحة  -لتغيير كلمة السر الخاصة بحسابنا في ويندوز نفتح قائمة ابدأ ونختار الأمر 

panel  حسابات المستخدمين ’ -ومن لوحة التحكم نختار الأمرUser Accounts  كما في الصورة 
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 لتظهر لنا النافذة التالية 

 

 لتظهر لنا النافذة التالية  Change your passwordونختار منها الأمر 
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ليتم تغيير الكلمة  - Change passwordحيث نقوم بكتابة كلمة السر الخاصة بنا ثم نضغط الزر 
 أما لحذف كلمة السر من نافذة التحكم بحسابات المستخدمين كما في وحفظ التعديلات 

 

  

لتظهر لنا نافذة تأكيد الحذف كما في  Remove your password -نختار الأمر إزالة كلمة السر 
 الصورة 

 

 كلمة السر وحفظ التعديلات ء ليتم الغا remove passwordوعندها نضغط على زر 

  

 ص بك تغيير صورة الحساب الخا

 ننقر بالزر اليميني على مساحة فارغة في سطح المكتب ونختار الأمر تخصيص لتظهر النافذة التالية 
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 لتظهر النافذة التالية  change your account pictureونختار الأمر 

 

من خارج هذه ويمكن من هنا الاختيار من الصور الموجودة مسبقا أو وضع صورة من اختيارنا 
 لتظهر النافذة التالية  browse for more picturesالمجموعة وذلك بنقر الزر 
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العملية وعرض لتظهر النافذة التالية لتأكيد  openونحدد مكان الصورة التي نريد اختيارها ونضغط 
 الصورة 

 

 وتصبح الصورة الجديدة تظهر في الشاشة الرئيسية للدخول 
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 الملفات و المجلدات 

المجلدات لتوفير  Windowsتستلزم العمل في الملفات والمجلدات. يستخدم  Windowsأغلب مهام 
تماما كما تستخدم مجلدات الورق المقوى لترتيب ، على الكمبيوترنظام تخزين من أجل الملفات 

مثل ، ثيرة من الملفاتمختلفة كالمعلومات في خزانة ملفات. يمكن أن تحتوي المجلدات على أنواع 
والبرامج. ويمكن نسخ الملفات أو نقلها من مواقع ، والفيديو، والصور، والموسيقى، المستندات

مجلدات ء إلى مجلدات أنشأتها. كما يمكن إنشا، أو الإنترنت، أو كمبيوتر، مثل مجلد آخر، أخرى
ء فيمكن إنشا، المستندات إذا كنت تنشئ ملفات وتخزنها في مجلد، ضمن مجلدات. على سبيل المثال

فيمكن ، مجلد جديد ضمن المستندات ليحتوي الملفات. إذا قررت نقل المجلد الجديد إلى موقع آخر
 ":  Fileبسهولة نقله مع محتوياته بتحديده وسحبه إلى الموقع الجديد الملف" 

 

لملف هو الوحدة الأساسية للتخزين والتي تمكن الكمبيوتر من تمييز مجموعة معلومات من غيرها. ا
أو ، أو حفظها، أو حذفها، أو تغييرها، يستطيع المستخدم استرجاعهاوهو مجموعة من البيانات 

 مثل طابعة أو برنامج بريد إلكتروني ، إرسالها إلى جهاز إخراج

 

 الملفات: ء إنشا

ملفاتها بطريقة سريعة ء لإنشا ملف بعض البرامج تضع اختصاراء قة سريعة لإنشاهناك طري
 كالتالي: 

 

 • نضغط بزر ماوس اليمين على سطح المكتب أو في أي مجلد. 
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 . New• نختار من القائمة الفرعية التي تظهر جديد 

 • ظهر قائمة فرعية أخرى نختار منها الملف المطلوب 

  

 أنواع الملفات : 

 أي ملف و عند كتابة اسم الملف نلاحظ بأن كتابة اسم أي ملف يتألف من قسمين: ء عند إنشا

 حرف.  219القسم الأول: هو اسم الملف يمكن وضع اسم للملف لغاية 

 من ثلاثة أحرف حصرا باللغة الانكليزية.  القسم الثاني: هو امتداد الملف )نوعه( و يتكون دائما

 نقطة ).( كما موضح بالشكل أدناه يفصل بين اسم الملف و نوعه 

 

 

 " Folderالمجلدات"

  

يتم ترميزه على الشاشة ، حاوية من أجل البرامج والملفات في واجهات تطبيق المستخدم الرسومية
 بواسطة صورة رسومية )رمز( 

لمجلد ملفات. المجلد هو وسيطة لتنظيم البرامج والمستندات على القرص ويمكن أن يستوعب ملفات 
 جلدات إضافية. مثلا وم

  

 اللصق  –القص  –النسخ 

 (: أخذ نسخة من ملف و وضعها في مكان آخر مع الاحتفاظ بالنسخة الأساسية.  copyالنسخ )

 ( : نقل ملف من مكان إلى مكان آخر.  cutالقص ) 

( : أمر تثبيت النسخ و القص عند تنفيذهما أي أن أمري النسخ و القص لا يتم الا  pasteاللصق ) 
 يمكن تنفيذ أمر النسخ و القص بعدة طرق: بتنفيذ أمر اللصق 

 

  Organizeنسخ الملفات من القائمة  -اولا:

 (  copy. نحدد الملف أو المجلد المطلوب نسخه ) 1

 نسخ.  و نختار منها أمر Organize. نفتح قائمة 2
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 . نفتح النافذة المطلوب وضع النسخة فيه. 3

 نختار أمر لصق.  Organize. من قائمة 4

 

 .النسخ باستخدام زر ماوس اليمين:  -ثانيا: 

 .نحدد الملف المطلوب نسخه. 1

 .نضغط بزر ماوس اليمين على الملف و نختار أمر نسخ. 2

 .نفتح النافذة المطلوب وضع النسخة فيها. 3

.نضغط بزر ماوس اليمين في مكان فارغ داخل النافذة و من القائمة الفرعية التي تظهر نختار أمر 4
 لصق. 

 

 النسخ باستخدام اختصارات لوحة المفاتيح:  -ثالثا:

 . نحدد الملف المطلوب نسخه. 1

 لأمر النسخ.  CTRL+C. باستخدام لوحة المفاتيح نضغط على زري 2

 . نفتح النافذة المطلوب وضع النسخة فيها. 3

 لأمر اللصق.  CTRL+V. من لوحة المفاتيح نستخدم الاختصار 4

  

 النسخ باستخدام السحب و الافلات بزر ماوس اليسار:  -رابعا :

. نفتح النافذتين نافذة المصدر التي تحتوي على الملف أو المجلد المراد نسخه و نافذة الوجهة المراد 1
 نسخة فيه. وضع ال

 . نسحب الملف أو المجلد بواسطة زر ماوس اليسار باتجاه نافذة الوجهة. 2

من لوحة المفاتيح ثم نلقي الملف الذي نقوم  CTRL. فوق نافذة الوجهة نقوم بالضغط على زر 3
 بسحبه. 

  

 النسخ باستخدام السحب و الافلات بزر ماوس اليمين:  -خامسا:

صدر التي تحتوي على الملف أو المجلد المراد نسخه و نافذة الوجهة المراد . نفتح النافذتين نافذة الم1
 وضع النسخة فيه. 
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 . نسحب الملف أو المجلد بواسطة زر ماوس اليمين باتجاه نافذة الوجهة. 2

 الملف أو المجلد داخل نافذة الوجهة )النافذة المراد وضع النسخة فيها(. ء . نقوم بالقا3

 ة نختار منها نسخ إلى هذا الموضع. . تظهر قائمة فرعي4

  

بتنفيذ أمر النسخ و لكن مع عدم  ملاحظة: تنفيذ أمر قص له نفس المراحل الستة التي مرت معنا سابقا
 الاحتفاظ بالنسخة الرئيسية في مكانها أي عملية نقل من مكان إلى مكان آخر. 

 

  Shortcutالاختصار  -سادسا:

طريقة سريعة لتشغيل برنامج مستخدم بشكل متكرر أو فتح ملف أو مجلد دون الذهاب إلى موقع 
 تثبيته 

 فوائد الطريق المختصر: 

 إلى القوائم . ء الوصول السريع إلى البرنامج بدون اللجو -1

 توفير مساحة تخزينية على القرص الصلب لأنه لا يحجز سوى حجم ضئيل .  -2

 يقوم بنفس مهمة الملف الأصلي .  -3

  

 الاختصار: ء وهناك عدة طرق لإنشا

 * باستخدام طريقة المعالج.. 

 * النسخ و اللصق اختصار. 

 

 اختصار باستخدام المعالج: ء إنشا
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 ثم انقر فوق اختصار. ، وأشر إلى جديد، .انقر بزر الماوس الأيمن فوق سطح المكتب1

أو ، إضافته كاختصارسار واسم الملف أو البرنامج الذي تريد اكتب م، .في مربع موقع العنصر2
 ثم انقر فوق التالي. ، انقر فوق استعراض للبحث عن اسم الملف

 

 

 ء. ثم انقر فوق إنها، .اكتب الاسم الذي تريد ظهوره تحت الاختصار3

 

يظهر رمز الاختصار على سطح المكتب يعرف الاختصار من السهم ء * عند الضغط على إنها
 الموجود على الرمز مثلا 

 

  

 اختصار باستخدام النسخ و اللصق اختصار: ء إنشا
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 . نفتح النافذة التي تحتوي على رمز البرنامج الذي سنأخذ منه الاختصار. 1

 . نضغط بزر ماوس اليمين على رمز البرنامج. 2

 . نختار من القائمة الفرعية التي تظهر تعليمة نسخ. 3

 . نضغط بزر ماوس اليمين على سطح المكتب. 4

 . نختار من القائمة الفرعية التي تظهر لصق الاختصار. 5 

 

  

 ثم انقر فوق خصائص. ، انقر بزر الماوس الأيمن فوق الاختصار، لتغيير خصائص الاختصار
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البحث عن الهدف: عند نسيان مكان البرنامج أو الملف الرئيسي يمكن بالضغط على هذا الأمر أيجاد 
 الملف و تحديده. 

ب من صندوق تغيير الرمز: يمكن تغيير صورة الرمز بالضغط على هذا الزر و اختيار المطلو
 الحوار الذي يظهر. 

 ات: ــــملاحظ

لا يحذف و لكنه لا يعمل في حال عدم  Shortcut.إذا حذفنا الملف الأصلي فان ملف الاختصار 1
 وجود الملف الأصلي كما أن ملف 

 الاختصار لا يحذف الملف الأصلي. 

إلى هذا البرنامج .إذا تغير اسم الملف الأصلي لبرنامج ما أو مكانه ثم استخدمنا الاختصار للوصول 2
 فان النظام سوف يبحث عن هذا 

 الملف و يجده ثم يشغله 
 

 أمن الحاسوب 
هو فرع من فروع التكنولوجيا المعروفة باسم أمن المعلومات، كما هي مطبقة على الحاسوب 

والشبكات. والهدف من أمن الحاسوب يتضمن حماية المعلومات والممتلكات من السرقة والفساد، أو 
الكوارث الطبيعية، بينما يسمح للمعلومات والممتلكات أن تبقى منتجة وفي متناول مستخدميها 

المستهدفين. مصطلحات أمن نظام الحاسوب، تعني العمليات والآليات الجماعية التي من خلالها 
لأنشطة تحٌمى المعلومات والخدمات الحساسة والقيمة من النشر، والعبث بها أو الانهيار الذي تسببه ا

 غير المأذون بها أو الأفراد غير الجديرين بالثقة، والأحداث غير المخطط لها على التوالي.
 

 فيروس الحاسوب

هو برنامج خارجي صنع عمداً بغرض تغيير خصائص الملفات التي يصيبها لتقوم بتنفيذ بعض الأوامر إما بالإزالة  
أن فيروسات الحاسب هي برامج تتم كتابتها بواسطة مبرمجين أو التعديل أو التخريب وما يشبهها من عمليات. أي 

  .محترفين بغرض إلحاق الضرر بحاسب آخر، أو السيطرة عليه أو سرقة بيانات مهمة، وتتم كتابتها بطريقة معينة
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Operating System 

It is a set of software responsible for managing resources (computer 

hardware) and computer software, and it represents an intermediary 

between the user and the computer hardware. In other words, it is a 

means to run user programs, and it performs basic tasks such as: 

managing and allocating computer resources (memory, hard disk, access 

to devices). accessories, etc., arrange the priority of dealing with 

commands, and control input and output devices such as: the keyboard, 

as well as to facilitate dealing with networks and file management . 

 

Windows operating system 

Definition of the Windows operating system The Windows operating 

system is a computer operating system developed by Microsoft with the 

aim of running personal computers. Where Windows versions are used 

by 90%. 

 

 

 

 

 

What is the use of the Windows operating system? 

The operating system is the most important software that runs on a 

computer. It manages everything related to the computer's memory and 

the processes that take place in it, as well as both software and hardware 

(software and hardware). It also allows you to communicate with a 

computer without knowing how to speak a computer language. Without 

an operating system, a computer is useless. 



1.To switch on a computer, you use the power button, this is a universal 

symbol for how to power on devices. When you press this button, your 

computer will start “booting up”. This means your computer is getting 
ready to be used and can take anything from 10 seconds to 5 minutes 

depending on the computer. 

2.Once the computer powers up after a short period of time you will 

come to a screen with a random artistic image as the background. 

 

3.Press the left mouse button once and it will disappear and be replaced 

with this. Click on “Sign in” with the left mouse button. If you have a 
password type it into the box that appears and click the arrow button. (If 

there isn’t a password created it will just sign in straight away). 

 

 

 

Desktop 

The main screen area that appears after turning on the computer and 

logging into the operating system 

 

 

 

 

 

 



1.This PC: Through it, hard disks, floppy disks, or units can be accessed 

Secondary storage such as an external hard disk, memory flash, or other 

Storage units. 

 

 

2.My Document: It stores files such as photos, videos, and documents. 

It is one of the main desktop components. 

 

 

3.Recycle Bin: it is one of the basic icons on the desktop that contains 

files that have been deleted these files can be recovered by entering the 

recycle bin, right-clicking, and selecting the command (Restore) and this 

deletion is considered temporary. as for the deletion, it is final, by 

pressing right-click on the recycle bin and select (Recycle Empty Bin). 

 

 

4.Microsoft Edge: It is a browser found in all modern versions of 

Windows, it's faster, safer, and includes a lot of new features, such as 

accessing blogs and social networking sites, as well as sending and 

receiving email Depending on the company like (Yahoo or Google).  

 

 

 

5.Start Menu: It is a list on the taskbar containing all the programs in 

which the computer has been turned off and restarted 

 



6.My Network: Through it, access to networks on the computer is 

controlled by all its settings. 

 

 

 

7.Task bar: It is a bar located at the bottom of the desktop that contains 

the start menu by accessing the history, controlling the volume, 

changing the language, and the Internet And other tools. 

 

 

 

How to change the size of desktop icons 

Wish the desktop icons in Windows 10 were bigger so you could 

stop squinting at them or they'd be easier to tap on a touch screen 

laptop? Or do you wish they were smaller so the shortcuts didn't 

take up as much space on your laptop's screen? Not to worry, we 

have a list of short steps on 

how to change the icon size in Windows 10. 

 

How to make small desktop icons: 

Right clock           view           small icons 

 

How to make medium desktop icons: 

Right clock           view           medium icons 

 

 



How to make large desktop icons: 

Right clock          view          large icons. 

 

How to make the arrangement of icons on the 

desktop automatically:  

Right clock          view         auto arranges icons. 

 

How to show icons on the desktop: 

Right clock           view          show desktop icons. 

 

             How to arrange icons according to size: 

               Right clock          sort by         size. 

How to arrange icons according to name: 

 Right clock           sort by         name. 

 

How to arrange icons according to item type: 

 Right clock           sort by item type. 

 

How to arrange icons according to data modified:  

Right clock            sort by data modified. 

 

 
Refresh: In general, refresh is another way of describing 
reloading or updating what is being displayed or stored. For 
example, if you were on a web page, refreshing the page would 
bring up the most recent content published on that page. 
Essentially, you're asking the site to send your computer the 
newest version of the page you're viewing. 

 

How to Create a New Folder in Windows 10?  

There are two ways: 

Method 1: Create a New Folder with a Keyboard Shortcut. 

ctrl + shift + N 



Method 2: Create a New Folder by Right-Clicking  

Right clock           new         folder. 

 
A file: It is a collection of information that is classified and stored 
in various ways to keep it and easily accessible at any time. 

 
A folder: is a virtual digital space in which a group of files of a 
certain type or of several types and formats are stored. 

 

Subfolder: A folder stored inside another folder. 

 

Naming folders: Should the folder name be short and indicate something, 
it is best if it indicates in one way or another the content of the folder. This 
makes searching for it easy, and anyone who glances at your computer 
quickly understands its organization. 

There are several ways to rename a folder: 

1-To rename a file from the context menu, right-click on a folder, and 

click "Rename" from the context menu that appears. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



2-Select the file or folder whose name you want to change by clicking on 

it with one click of the left mouse button, and then adding the new name. 

 

 

 

 

 

 

 

 

 

 

 

H ow to show the main icons on the Windows 10 desktop? 

Right clock           personalize          themes         desktop icons setting 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



How to change Windows 10 desktop background? 

1-Right click. 

2-personalize. 

3-Click on the background and the page for the background images will 

appear. 

4-Click on the box below Background to select a specific picture or 

color, or you can do a background slideshow. 

How to change windows 10 lock screen?  

1- Right click. 

2-personalize. 

3-lock screen. 

4-Click on the box below Background to select a specific picture or 

windows spotlight, or you can do a lock screen slideshow. 

 

How to change windows 10 themes? 

1.Right click the Start menu and select Settings.  

2.Choose Personalization from the Windows Settings menu. 

3.On the left, select Themes from the sidebar.  

4.Under Apply a Theme, click the link to Get more themes in the store. 

5.Choose a theme, and click to open a pop-up to download it. 
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Word 2016 

Home Tab 

1- Clipboard group 

2- Font group 

3- Paragraph group 

4- Style group 

5- Editing group 

1- Clipboard group 

Cut, Copy and Paste 

highlight the text and go to the Home tab in the Clipboard group 

 and click Cut or Copy. You can also right click on your mouse 

and select Cut or Copy. 

the Paste Options button provides different options, depending on the source of the 

content as in the table below, see figure 1. 

Keep Source Formatting: This option preserves the look of the original text. 

Keep Text Only: This option removes all the original formatting from the 
text. 

Merge Formatting: This option changes the formatting so that it matches the 
text that surrounds it.

highlight the text or select text  تعني
 تظليل النص 

خطوات التنفيذ تقريبا متشابه لأغلب التنسيقات 
سوف نطبق على البعض ويقاس على البقية لتجنب 

 التطويل 
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Figure 1 copy and past 

2- Font group 

Font Formatting  

Highlight the text you want to format and then select the font, size, style, and color 

under the Font group. 

 For additional font options, click the Show Font 

Figre 2 change the type of font and size of it 

1

2

3

4 

1

2
3

4
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Bold (Ctrl+B): Highlight the text -> from font group -> click B 

Italic (Ctrl+I) : Highlight the text -> from font group -> click I 

And so on for all 

Increase Font Size  

Decrease Font Size 

Change Case:  

This for English language 

Font Color 

MSC.Ahmed Kareem
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3- The Paragraph Group 

Paragraph Formatting  
Paragraph formatting options are available under the Paragraph group. The following 
options are available from the Paragraph group:  

- Bullets and numbered lists 

- Indentations, Sorting & Display 

 Format Symbols 

- Alignment 

- Line spacing, Shading, & Borders 

. 

Figure 3: Bullet and center alignment 

For additional paragraph 

formatting options, click the 

Show Paragraph Dialog Box 

icon 

1 

4 

3 

2 
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How to align text 

1. From the Home Tab, find the Paragraph toolbox.

2. Select the text that you would like to align.

3. Select the icon for left, center, right, or plain justify, justification. Your text will have

the justification of your choice 

How to change the line and paragraph spacing 

1. From the Home Tab, find the Paragraph toolbox.

2. Select the text that you would like to change the spacing.

3. Select the icon for line and paragraph spacing. The dropdown arrow will allow you

to see the different choices for line and paragraph spacing 

As shown in this figure 

4- Style group

Changing the style of text can make your document look amazing. You have several 

choices to choose from

How to change the style of text 

1. Select the text that you would like to change the style of.

2. From the Home Tab, find the Styles toolbox.

3. Click the style that you would like to change the text to.

MSC.Ahmed Kareem 
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Create new style 

1- write any text 

2- highlight the text 

3- format the text (size, type .....) as you want 

4- from style group, click the arrow in the right - below in style group 

5- Click the create a Style

 6- Name it and press ok 

We note the style name will appear in the style group 

MSC.Ahmed Kareem
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5- Editing group 

The editing toolbox allows access to the Find tool. This tool 

allows you to locate certain words in your document.  

You can also access the Replace tool which allows you to  

replace words of your choice. 

Find : search on your words inside the document 

Replace : 

1 

3 

2 

1 

3 

2 
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How to use the Replace button 

a. From the Home Tab locate the editing toolbox at the far right of the ribbon.

b. Click the Replace button in the Editing toolbox. The Find and Replace dialog box

will display. 

c. Type in the word to find and then type in the word you would like to replace it with.

d. Click Replace or Replace all.
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1- Insert 

 

1.1 Table 

To create new table do the following 

Insert        table        insert table        write number of columns & row    ok  

See figure 1 
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1.2  Picture 

To insert picture for your word document, do the following 

Insert         Picture          select the desired image file in dialog box          click Insert  

See figure 2 

 
 

 

 

 

 

 

 

 

1.3  Shapes 

Insert        shapes        select desired shape       draw the shape in the desired place 

1.4  Screenshot 

Insert        Screenshot        select desired screen or window of any opened 

program Insert        Screenshot       screen clipping 

1.5  Hyperlink 

A hyperlink is a word, phrase, or image that you can click on to jump to a new document or a new section within the 

current document 

Select the word/phrase/ image        insert        hyperlink       select the file you want   ok   

See figure 3 
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 If move mouse to the linked text as shown in figure 4-B will appear phrase (Ctrl + click to follow 

link) and if you do that, the file will be opened. 

 

1.6  Header & Footer 

Insert       Header       select the desired one        update it and write what you want   

see figure 4  
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1.7  WordArt 
 

Insert        WordArt        select desired style        write the text 

Figure 5 

 

 

 

 

 

 

 

 

 

 

 

 

1- Design & Page Layout 

1.1  Watermark 

A watermark is an identifying image or text in paper that appears as various shades of 

lightness and you can do by follow the: 

Design        Watermark       custom watermark       text watermark       write text   ok  

 See figure 6  
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1.2  Page Color 
 

Design        page Background        page color        select color                                                                                                      

As shown in figure 7 

 

 

 

 

 

 

 

 

 

1.3  Page Borders 
 

Design        page Background        Page Borders       select border from border box   ok 

 See figure 8 
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How to change Brightness in windows 10? 

In Windows 10 Select Start, choose Settings, and then select System choose Display. Then 

Brightness and color move the Change brightness slider. 

 

 

 

 

 

 

 

 

 

 

 

How to change night light settings in windows 10? 

In Windows 10 Select Start, choose Settings, and then select System choose Display. Then night 

light. If your night light toggle is grayed out, you may need to update your display driver, toggle 

Schedule night light to on.  

 

 

 

 

 

 

 

 

 

 

Start Settings System Display Brightness 

Start Settings System Display Night light 
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How to change size of text in windows 10? 

Follow the steps below to change both the Text size and the size of App icons as they appear on 

the screen of your computer.  

1. Right-click on any empty space on the desktop  

2. And click on Display settings. Open Display Settings on Windows Computer Alternatively, 

you can reach the Display Settings by going to Settings > System> Display. You will 

immediately notice the Text size and App Icons appearing larger. However, you will have to Log 

Out of your computer and Login back again to implement this change.  

3. Hence, Log out and Login back to apply the changes. 

 

 

 

 

 

 

 

 

  

 

 

 

             

 

 

 

 

 

 

Start Settings System Display Scale&layout 

Change size of text 
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How to change screen resolution on windows 10? 

In the Display screen, scroll down to the "Scale and layout" section. Click the box under 

"Display resolution" to see your available options. 

 

 

 

 

 

 

 

 

 

 

 

 

How to change Display orientation on windows 10? 

Select Start  > Settings  > System > Display, and choose a screen orientation from the drop-

down list labelled Orientation. 

 

 

 

 

 

Start Settings System Display Scale&layout 

Display resolution 
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Quick Actions 

Windows 10 makes it easier for you to add, remove, or arrange the Quick Action button ns in the 

Notifications & Actions Center. The Action Center displays four Quick Actions, with an option 

that lets you Expand or Collapse the Action Center in order to show more than four buttons. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Start Settings System Display Scale&layout 

Display resolution 

Start Settings System Notifications & actions 

Quick actions 
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Notifications 

Action center in Windows 10 is where you will find your notifications and quick actions. Change 

your settings at any time to adjust how and when you see notifications and which apps and 

settings are your top quick actions. 

 

 

 

 

 

 

 

   

 

 

Power and Sleep 

Change Power and Sleep Settings in Windows 10 to manage your computer uses power. Power 

and Sleep Settings can help to save energy or maximize system performance your devices. 

 

 

 

 

 

 

 

 

 

Start Settings System Notifications & actions 

Notifications 
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Battery saver 

 When the battery saver is enabled in Windows 10, the screen’s brightness is set to a low level, 
and the background activity, and push notifications are disabled to save energy. Windows 10 

enables the battery saver automatically when the battery level below 20% or a custom level set 

by the user. 

 

 

 

 

 

 

 

 

 

 

 

 

Start Settings System 

Screen 

Power & Sleep 

Start Settings System 

Sleep 

Power & Sleep 

1 

2 

Start Settings System Battery saver Battery 
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How to set your time and time zone 

In Date & time, you can choose to let Windows 10 set your time and time zone automatically, or 

you can set them manually. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Start Settings Date & time Time & language 
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Manage display language settings in Windows 

The display language you select changes the default language used by Windows features, such 

as Settings and File Explorer. 

1. Select Start  > Settings  > Time & language > Language & region. 

2. Choose a language from the Windows display language menu, or, next to preferred 

languages, select add a language to install the one you want if it is not listed. 

 

 

 

 

 

 

 

  

Start Settings Date & time Time & language 
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Word 2016 

Microsoft Word 2016 

Microsoft Word 2016 is a word-processing program, designed to help you create 

professional-quality documents. With the finest document-formatting tools, Word 

helps you organize and write your documents more efficiently. Word also includes 

powerful editing and revising tools so that you can collaborate with others easily. 

The Ribbon 

Understanding the Ribbon is a great way to help understand the changes between 

Microsoft 2003 to Microsoft 2016. The ribbon holds all of the information in previous 

versions of Microsoft Office in a more visual stream line manner through a series of tabs 

that include an immense variety of program features. 

Home Tab 

This is the most used tab; it incorporates all text formatting features such as font and 

paragraph changes.  

 

Insert Tab 

This tab allows you to insert a variety of items into a document from pictures, clip art, 

tables and headers and footers. 
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Page Layout Tab  & Design Tab 

This tab has commands to adjust page elements such as margins, orientation, inserting 

columns, page backgrounds and themes. 

 

 

Opening Outlook (word program window) 

You may have a shortcut to Word on your desktop, if so double click the icon and Word will open. If 

not follow the steps below:  

1. Click on the Start button  

2. Click on all Programs  

3. Click on Microsoft Office 

 4. Click on Microsoft Word 2016  

Create a New Document from desktop  

1- Right click then new 

2-  Click Microsoft word document 

After click on the Microsoft Word 2016 or on any Microsoft Word document the 

following window will present 
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The Quick Access Toolbar 

The Quick Access Toolbar is located in the bottom left corner and is intended to store 

the buttons you will use most often. 

 

By default, the Quick Access Toolbar shows the Save, Undo, and Redo buttons, however 

if you click on the drop down arrow just to the right, you can customize it to fit your 

needs. In the example below, I have added the Quick Print button. The Save icon (which 

appears as a floppy diskette symbol) is convenient to click on when wanting to save your 

work instead of clicking on the Save icon from the File tab. 
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File Tab:- 

In Microsoft Word and other Microsoft Office products, the File tab is a 

section on the Office ribbon that gives you access to file functions. For 

example, from the File tab, you can access the Open / Recent file options, 

Save, Close and others tools. The image below is of Microsoft Word 2016 

in the following will explain some functions of file tab 

1- Save 

While editing an existing file, it’s a good habit to often  

save your work. There are two different ways to save  

files. Click the File tab, then just click the Save button.  

The faster option as described earlier, is to click the  

Save button in the Quick Access Toolbar. 

2- Save as  

When editing an existing document, you may want to  

save the file under a different name or in other location  

with same or other name.  

Click on the File tab, click the Save As button and the Save As dialog box 

opens as seen below. In the File name field, type in the new name without 

changing the .docx extension. Click the Save button. 
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Select Location                          Type name 

 

3- Open an Existing File 

To open an existing file, you’ve created, click on the File tab, click the Open 

button and the familiar Open dialog box appears as seen in the next screen 

shot below. 
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Recent Option 

The Recent option in (open) allows you to quickly go to your other documents and 

open them 

If select Browse  

the familiar Open dialog box appears as seen in the next screen shot below. 

 

Click on the file you want, then click Open at the bottom right. 
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4- Print  

Use for print  word document, File then print  

 

 

Encrypt The Word Document: 

To make the word document not available for others, we can encrypt the word 
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document with password.

1- click file

2- click info then protect Docu.

3- choose encrypt with password 

4- write your password
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1- Computer Definition.

• Computer is an electronic machine, that

process the input data according to the given

instructions(program) & gives output information

or signals as a result. It also saves the result for

the future use.

Figure (1) The working of computer contains 1

Input Processing  

Secondary 

unit

Output



• In the past humans use signals to speech and understanding

• Then use fingers to calculate

• Writing on wicker panels and papyrus and then writing

leather panels

• Then writing on paper with ink

• The first calculation machine created

named (Abacus).

• In 1812 created the (Mechanical Calculator)

by the Invented (Pascal) named (Pascalian).

• In same year created (Analytical Machine), ability to

implementation the four operations (Addition, subtraction,

multiplication and division) named (Grand Father).

2- Historical

Development
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• In 1923 appear the first machine named

(Electromechanical Machine) by the Inventor (Hawerd)

from Slvania University in USA.

• In 1946 appear the first computer named (ENIAC)

(Electronic Numerical Integrator And Computer) by the

Inventor (Ekentemockely), this computer used Vacuum

Tubes named (First Generation) .
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• (EDVAC)(Electronic Discrete Variable Automatic Computer)

• computer became able to store

programs instead of the entry  manually. 

• (UNIVAC) (Universal Automatic Computer)

• computer in first time used magnetic tapes

for storing information until 1981 when

manufactured personal computer (PC)

• by International Business Machines Corporation (IBM)
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3- Computer Generations.

• First Generation (1945-1951) 

• Second Generation (1952-1960) 

• Third Generation (1961-1969)

• Fourth Generation (1970 - present) 

• Fifth Generation (present-beyond) 
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Technology: Vacuum Tubes

The first computers used vacuum tubes for circuitry and

magnetic drums for memory, and were often enormous, taking

up entire rooms.

Characteristics 1st Gen.

1-Difficult in using because it was used

for primitive Languages

2- Slow, the time unit in Milli Second. (1 ∗ 10−3).
3- The memory is very limited.

4- Very expensive.

5- High power consumption.

6- Generate a lot of heat.

7- The size is very large.

8- Their were often the cause of malfunctions.
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1-First Generation (1945-1951) 



2-Second Generation (1952-1960) 

• Technology: Transistor

• Invented in 1952 by (William Shockley, John Bardeen,

and William Brattain).

• Characteristics 2nd Gen.

1-Use Transistor instead of Vacuum Tubes

2-Use language more easy than machine language

such as Fortran & Koppel languages.

3-The size smaller than previous generation

4- Increase the speed, the time unit

in Microsecond(1x10−6 𝑠𝑒𝑐. )
5-Increase the capacity of memory .
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• Technology: Integrate Circuit (IC)

• With appear the Integrate Circuit also appear the third

generation and small computers.

Characteristics 3rd Gen.

1-More increase in the speed, the time unit in

Nanosecond. (1x10−9 𝑠𝑒𝑐. )
2-Increase numbers of users because easy to use.

3-The size smaller than second generation.

4-The cost is cheap.

5-Multiple practical applications.

3-Third Generation (1961-1969)
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• Technology: Micro Chips

• Created the Personal Computer, The (PC) was introduced by

IBM Corporation, in 1981.

• The number of personal computers in use more than

doubled from 2 million in 1981 to 5.5 million in 1982. Ten years

later, 65 million PCs were being used.

Characteristics 4th Gen.

1-The size is very small.

2-Wide spread.

3-The cost is very cheap.

4-Easy to use.

5-Use languages such as Basic language.

4-Fourth Generation (1970 - present)
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• Technology: Artificial Intelligence

• In (1985) Japanese development the program for Artificial

Intelligence(control the Robot) .

• Characteristics 5th Gen.

1-The speed is higher than previous generations.

2-The capacity of memory bigger than previous generations

3-The size of equipment is better.

4- Safety in Information Security

5-Created new memory units such as

(CD,DVD, floppy disk …etc)

5-Fifth Generation (present-beyond)
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4- Computer Contains:-

A- Hardware :-Refers to the physical components

(Electronic and mechanical equipment),it includes

the keyboard ,mouse, and monitor and other

devices.

B- Software :- Refer to the programs which consist

of the step by step instructions that tell the computer

how to do its work.
11



1- System unit :

Is a container which consists of the electronic components

that make up computer system, two important components of

it:

A- CPU (Central Processing Unit ).

B- Memory dividing to RAM & ROM.

CPU and the memory was installed on system board or mother

board. The mother board connect all system components to

each other.

2- Input/output units.

3- Disk Drivers.

4- Peripherals ( الطرفيةالأجهزة ).

A- Hardware
Computer main parts:
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1- System unit :

A)- CPU (Central Processing Unit):-

-Also called a processor.

-Carries out instructions that tell computer what to do.

-The CPU is the brain of any computer and most important

element of a computer system.

-It coordinates its function with other computer units, it has

two basic component :

1-ALU (Arithmetic & logic Unit)

2- CU (Control Unit)
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2- CU (Control Unit)

It controls the flow of instruction within

the system. It directs the movement

of electronic signals between memory,

instructions , processed information

and arithmetic logic unit.

It also control the signals between

CPU and output device.

1-ALU (Arithmetic & logic Unit)

Perform two type of operation :Arithmetic & logical .

Arithmetic operation like( addition, subtraction,

multiplication and division).

Logical operation like(comparisons operation).
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B - Memory:
This unit stores instructions and information, and it’s Divided 

into two parts:

1-ROM (Read only memory):

- it is programing chips.

- have programs built into them at factory.

- they are not violet .

- cannot be changed by the user.

- like ROM-BIOS chip.
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2-RAM (Random access memory):

- Also called Primary Memory.

- It stores the data, information and programs temporally.

- the  data can written on it and deleted constantly.

- Called violet because everything is lost as soon as the 

computer is turned off.

-measured by Mbyte, It ranges from 64 MB to 16 GB. 
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Input units :used to enter

the data and commands to

the computer such as:

- keyboard + touch screen

- Mouse 

- Scanner

- Camera

- Microphone (voice inputs)

- Barcode Reader

- Light pen 

- joystick 

- DVD (Digital Versatile Disk)

- Floppy disk

Outputs units: used to show 

the data and commands like:  

-Monitor 

-Printers

-Plotters 

-Data show 

-Speakers 

-Magnetic Tape 

-CD (Compact Disk)

-DVD (Digital Versatile Disk)       

-Floppy disk 

2)-Inputs/Output units:
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3-Disk Drivers:

-Secondary storage : store data and program even after the

power of computer turned off.

Such as: floppy disk, hard disk, and optical discs

(CD , DVD ).

4-Peripherals ( الطرفيةالأجهزة ):

- Any piece of hardware that is connected to a computer to

perform a special task such

as modem and speakers.
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Thank you
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